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Introduction

Welcome to the Scitex MaskCutter™ program—the desktop software that lets you
perform superior quality mask-cutting directly on your Macintosh®, MaskCutter
provides both simple and sophisticated tools and an easy to use interface for
cutting high-resolution full color images. Whether you’re new to image editing or
a professional graphic artist, you’ll find that using MaskCutter helps you increase
overall productivity because now, you can use the power of the Scitex workstation
on your Macintosh.

Most of the printed images you see in magazines, glossy advertising, and full-color
brochures are created using masks. Many techniques used in mask design require
high-end workstations. MaskCutter brings the technology to your Macintosh,
providing seamless integration into a desktop production environment.

Introduction 7



About This Manual

The Scitex MaskCutter User Guide contains detailed information about the
operation of Scitex MaskCutter. It is designed to get you up and running quickly
as well as serve as a reference for accomplishing more complex procedures.

The Scitex MaskCutter User Guide assumes that you have a working knowledge
of Macintosh functionality. You should know the menu commands found in
standard Macintosh applications and how to select and drag using a mouse. You
should also be familiar with opening, saving, and closing files. If you need
instructions on performing these operations, see the documentation provided with
your Macintosh.

The Scitex MaskCutter User Guide information is presented in an ordered
sequence according to the tasks you need to accomplish.

Chapter 1, “Installation,” describes the steps needed to install Scitex MaskCutter
on your Macintosh, including system configuration and performance-optimizing
suggestions.

Chapter 2, “MaskCutter QuickStart,” steps you through a standard masking
operation so you can get started right away.

Chapter 3, “MaskCutter Tools,” provides an in-depth description of each tool,
including tips for cutting masks, and a discussion of advanced techniques for
masks settings.

Chapter 4, “Menu Options” contains explanations for each command available
in the menus.

Chapter 5, “Workflow Scenario,” describes the workflow for using Scitex
MaskCautter in a Postscript environment.

8 Scitex MaskCutter User Guide



Chapter 1: Installation

This chapter contains all you need to know to get up and running with Scitex
MaskCutter, including system configuration, installation instructions and sugges-
tions for maximizing performance.

Hardware Configuration

Minimum Requirements

Your computer system must meet the following requirements to use Scitex
MaskCutter:

* A Macintosh II

* 6MB RAM

e A 256-color monitor

Some Macintosh models require a graphics card to support 8-bit color.
e 3MB disk space free for installation

® Additional disk space as needed for images

Recommended Configuration

To take full advantage of the power of Scitex MaskCutter, your system should
meet these recommendations:

* Macintosh Quadra or better

64MB RAM or more

An accelerated 24-bit video card
® Macintosh System 7.1.2 or higher

e A 16" screen or larger

A 100 Mbyte internal drive

Chapter 1: Installation 9



Installation instructions

Information on registering Scitex MaskCutter is to be completed once the installa-
tion process is finalized.
Recommended Software Settings

e All RAM except 6MB should be dedicated to RAM disk. This option is only
available on Quadra, Centris or PowerMac models.

® Make sure that Virtual Memory is turned Off. Using Virtual Memory slows
down the application considerably.

* If your display is capable of 24-bit color, make sure that the monitor is always
set to 24-bit (Millions). Images display faster in 24-bit mode and the quality is
much better.

The larger the partition you set, the greater the effect you will experience on the

speed of the save and open operations.
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Registration

The first time the application is launched, the following dialogue box appears:

Name: I

Organization: [

Registration Number: |

The user is required to fill all fields. This information is then confirmed by clicking
the “Register” button. The user now has a fully functioning version. The registra-

tion number will not be required again to launch MaskCutter.

If the “MaskCutter Preferences’ file is removed from the preferences folder the
user will be requested to enter the registration number again.

Chapter 1: Installation 11




If the user entered a wrong registration number - the following message will be
displayed:

Sorry, you got the wrong registration
number. Scites MaskCutter™ will run in
demo mode.

The only mode available for work will be demo mode, that is, the user will not be
able to save any work.

If the registration number is already used by someone else on the network - the
following message will appear:

Sorry, somebody else is using
MaskCutter. MaskCutter will run in demo
mode.

=)

Again, the only mode available will be demo mode.
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Chapter 2: MaskCutter QuickStart

This chapter describes a typical scenario, stepping you through each activity
needed to produce a finished mask. Only basic operations necessary to complet-
ing this simple task are discussed. The “MaskCutter Tools” and “Menu Options
chapters contain descriptions of the tools, tips on cutting masks, and definitions
for each menu command. Depending on the tasks you need to accomplish, you
may want to scan those chapters as you work through this QuickStart operation.

There is also a Tutorial to allow you to become familiar with all the tools
available with MaskCutter

Chapter 2: MaskCutter QuickStart 13



Cutting a mask

Masks are used to isolate, or cut, a part of an image. Typically, the portion of an
image used in a mask is placed outside its original context. For example, you
could cut a mask of a person from an image of a birthday party to overlay on an
image of a deserted beach.

Once you have a Scitex Continuous Tone (CT), TIFF or PhotoShop EPS image file
on your Macintosh, you are ready to cut a new mask using MaskCutter.

1. Choose Open Image & New Mask... from the File menu.

The Choose Image File window is displayed containing pictorial representations
of the image files in the active folder.

Choose Image File to Mask: Create Preview View: _

2

= Ravanelli
= Flower ¥ m

0 Model

Type: CT size: 866 KB

Choose Image File window

m If all you see are boxes with an “X™ through it, try selecting the Create Preview

button to create pictorial representations for your images.
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Smooth Polygon tool = \

2. Choose an image file to be masked

Tip: You can select from the preview images or from the list box of file names.

3. Press the Open button

The image you selected is displayed, ready for masking.

Toolbox, image for masking, and image Navigator window
4. Click on the Smooth Polygon tool

5. Click on a starting point for the polygon

A small square is displayed marking the point.

6. Click on another point along the edge of the image

Another small square is displayed marking the second point.

7. Click on a third point along the edge of the image

A curved line is drawn to connect the first two points.

Chapter 2: MaskCutter QuickStart
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8. Continue clicking on points along the edge of the image

Smooth Polygon Masking tool

9. Close the polygon by clicking on the initial point of the polygon
A red translucent overlay appears inside the polygon, indicating the masked
area.

10. Choose Save As... from the File menu

The Save As dialog box is displayed.

&3 MaskCutter v = Ravanelli
0O Flower = [ Fject ]
0 Madel

&l

Save mask as:
'\-1 odel{Zi14 | i

File Format:| MaskCulter «

seve

11. Enter a name for the mask file
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12. Choose EPS File Format
13. Set required values for Preview and Encoding

14. Press the Save button

The mask you created is saved, and you can combine it with others to form

composite images.

Selecting the other File Format options available will produce different options.
For full details of these consult the relevant sections in the “Menu Options: File
Menu Commands” section.

Chapter 2: MaskCutter QuickStart 17



Transporting Images and Masks

When you save a mask, MaskCutter saves a reference pointer to the image file you
used for creating the mask. That referenced image file must be present on the
machine, or an attached external device, you will use for final output. Further,
image filename must be the same as it was when you created the mask.

If MaskCutter cannot find the image file, it will prompt you to help locate it. Try
checking the image filename and ensure that the image is present. This is critical
when you are working on multiple systems to create final output.

For MaskCutter to function, the image file must be present and must be named as
it was when you created the mask.

18 Scitex MaskCutter User Guide



Going beyond the basics

The steps in this chapter allow you to accomplish only the most basic of the
operations available in the MaskCutter application. They are designed to get you
started in a hurry using the minimal amount of information you need.

To give you some direction to where you might go next, here are some sugges-
tions:

¢ You’ll learn more about the mask-cutting tools in the Cutting Masks section of
Chapter 3, “MaskCutter Tools.”

e Starting with Chapter 3 works best for those who use functionality to guide
them in their learning process.

¢ Those who learn best by following step-by-step procedures will find the Using
MaskCutter’s tools section in Chapter 3 the most helpful. A stepped-through
activity accompanies each tool, and illustrations appear throughout.

e If you learn best by building on ideas and suggested techniques, check out the
Hints and tips for cutting masks section in Chapter 3.

e For an in-depth discussion of the more advanced settings for masks, see the
Advanced Techniques section in Chapter 3.

» If you want to understand the menu options available in MaskCutter, see
Chapter 4, “Menu Options.” This chapter also describes dialog box options
associated with menu items. For example, the File Menu section discusses how
to decide on a format for saving your mask file.

e If you have questions about flow of work and environments MaskCutter
supports, look at Chapter 5, Workflow Scenario for answers.

* Finally, you can use the table of contents and index to search for topics and

direction.

Chapter 2: MaskCutter QuickStart 19
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MaskCutter toolbox

Chapter 3: MaskCutter Tools

This chapter describes the tools available in the toolbox. MaskCutter offers six
tools for cutting and editing masks, three tools for navigating in the image area,
and one tool for large-scale mask manipulation.

Understanding Cutting Masks

The following sections contain procedures along with tips and techniques for
cutting masks.

Cutting masks

The six mask-cutting tools, Polygon, Smooth Polygon, AutoMask, DensityMask,
Rectangle, and Oval are all used for cutting masks. You can use these tools
interchangeably as you create a mask. When a new marked shape overlaps an
existing map, the two areas merge.

If a mask already exists on the image, the area is added to it. If you are in inverted
mode, the cut shape is removed from the mask area when you close the polygon.
If you are not in inverted mode, but you want to subtract this area from the
existing mask, press the Option key when closing the polygon.

A red translucent overlay, similar to a piece of rubylith, covers the entire area
included in the mask. You can select a different color, pattern, or level of opacity
for the mask overlay using items on the View menu.

Chapter 3: MaskCutter Tools 21




Tool types

MaskCutter’s manual masking tools provide for edge marking and area marking.
When you use the Polygon and Smooth Polygon tools to mask an element, you
trace along the edge of an element. When you use the Rectangle or Oval manual
masking tools, you mark an entire area of an image.

When you join two ends of a path traced along an image edge, a polygon is
created, encompassing the entire area you traced around. If you do not join the
ends, a mask containing only the traced edge is created, that is, it is an incomplete

mask.

X [c [=] [

Manual Masking Tools - Polygon, Smooth Polygon, Rectangle, Oval

The MaskCutter automatic masking tools mark the edge of an image for you.
The two tools, AutoMask and DensityMask, provide very powerful technology
for creating masks automatically.

o
Jéi

Automatic Masking Tools - AutoMask, DensityMask

22 Scitex MaskCutter User Guide



Hints and tips for cutting masks

You can easily modify an existing mask, adding or deleting edges, and areas. An
element of an image that contains highly contrasting contours is best suited for
using the AutoMask tool. An element consisting of straight edges is most-easily
masked using the Polygon tool. Rounded-edged elements are best masked using
the Smooth Polygon tool. And a specified, regular area of an element is best
masked using the Rectangle or Oval tool. For each segment of an image, use the
tool best suited for it.

When you cut a mask with the Polygon, Smooth Polygon or AutoMask tools, you
can delete the last marked point. When you click on a point you do not want, you
can delete it by pressing the delete key. Each press of the delete key deletes one
point. You can delete the entire polygon, point by point, by continuing to press

the delete key.

To preview where a new line segment will cut, drag the cursor until the line is
positioned where you want it. Then release the mouse button.

You can choose from four methods to close a polygon:

* Click on the initial point of the polygon

* Double click on the image

» Select Close Polygon from the Edit menu.

® Press the Command+K keys to invoke the keyboard shortcut

One of the most important techniques to master is navigating within an image.
Becoming adept at moving to different positions on an image speeds your work

considerably. For detailed instructions and examples on navigating in an image,
see the Navigating within an image section in Chapter 4.

Chapter 3: MaskCutter Tools 23




Constrained cutting
* Holding down the Shift key as you cut polygons, constrains lines to multiples of

45-degree angles.

* Holding down the Shift key as you cut rectangles or ovals, constrains their

shape to squares or circles.

¢ Holding down the Control key as you draw rectangles or ovals draws the shape
using the initial point as the center.

* Holding down Shift and Control as you draw rectangles or ovals draws a
square or circle using the initial point as the center.

24  Scitex MaskCutter User Guide



Pan tool

Pan cursor

@‘?

Using MaskCutter’s Tools

The Pan tool allows you to reposition the area visible within the image window.
Use this tool when you are working with an image that you may have cropped
with another application or one that is larger than the image window.
Panning an image

In this procedure, you will reposition the image.

1. Click on the Pan tool

2. Position the cursor on the image

The cursor changes to the pan cursor as soon as it is within the image window.
3. Drag the image until the visible area is positioned as you want it

4. Release the mouse button

Tip: You can also pan using the scroll bars at the right and bottom of the image
window, or the Navigator Window.

E3o . —— Flower —————0@
[&]

[

Panning the image
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The Polygon tool allows you to cut a straight-line mask contour for an image
element. MaskCutter connects each point you click as you trace along the
contour. When all points in the polygon are connected, the polygon-shaped mask
is complete.

Cutting a polygon-shaped mask

In this procedure, you will create a mask with the Polygon tool.

Polygon tool F 1. Click on the Polygon tool

2. Click on a starting point for the polygon

A small square is displayed marking this point

3. Click on another point on the edge of the image
A small square is displayed marking this point.
4. Continue clicking on points along the edge of the image
5. Close the polygon by clicking on the initial point of the polygon
The Smooth Polygon tool allows you to draw a polygon around a curved shape.
MaskCutter connects the points with a curved line as you trace along the image.

When all points in the polygon are connected, the polygon-shaped mask is
complete.
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Smoaoth Polygon tool

Cutting a smooth polygon-shaped mask

In this procedure, you will create a mask with the Smooth Polygon tool.
1. Click on the Smooth Polygon tool

2. Click on a starting point for the polygon

A small square is displayed marking the point.

3. Click on another point along the edge of the image

Another small square is displayed marking the second point, but no line is yet
cut between the points. Two points of a smooth polygon connect only when a
third point is specified, in order to determine the curve between the first two

points.

4. Click on a third point along the edge of the image

A curved line is cut to connect the first two points.
5. Continue clicking on points along the edge of the image

6. Close the polygon by clicking on the initial point of the polygon

Chapter 3: MaskCutter Tools 27




Editing a polygon-shaped mask

In this procedure you will edit a mask you have previously created.
1. Click on the Polygon tool
2. Click on a starting point for the polygon, outside the mask

3. Click on another point, inside the mask

4. Click on a third point, again inside the mask

Closing the polygon at this point will add these points to the mask. Pressing the
Control key whilst closing the polygon subtracts these points from the mask.

Smooth Polygon Masking tool

The AutoMask tool lets MaskCutter automatically mark the edges of an element
for you. AutoMask works best when two images, or an image and its back-
ground, have clearly defined contours and distinct borders.

However, you can customize tool options to maximize AutoMask functionality,

even on difficult-to-mask images. For extensive information on AutoMask
options, see the Advanced techniques section later in this chapter.
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AutoMask tool

Cutting with AutoMask

In this procedure, you will experience cutting with the AutoMask tool.

1. Click on the AutoMask tool

When you select the AutoMask tool, the cursor becomes a rectangle, the
AutoFrame.

2. Drag AutoFrame along the edge of the image element you want to include in
the mask

MaskCutter applies image analysis algorithms to pixels inside the AutoFrame
rectangle. The algorithms detect an edge and mark it. A polygon is automati-
cally drawn around the detected edge.

In the following figure, AutoFrame detected an edge and determined the path. In
the path on the left, the AutoFrame was dragged to the left. In the path on the
right, the AutoFrame was dragged to the right.

T Ml e el

AutoMask Edge Detection

If you drag the AutoFrame along a path where it cannot detect an edge, a beep
sounds and no new mask segment is cut. The beep indicates insufficient contrast
between the contours inside the AutoFrame. Drag to a different location till all
elements you want are included, or supplement the masked area using other tools.
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m To use AutoMask, you must be in Full detail view or larger. AutoMask does not

work when you are in Actual Size mode unless this is the same size as the Full
detail view.

The DensityMask tool lets you automatically mask image areas that are distin-
guished by their color value. DensityMask is especially helpful for separating an
element from its background.

The DensityMask tool automatically creates a mask that covers all the image
pixels within the range of colors you select. Typically, you will click directly on
the colors you want added to the mask. However, you can preview the exact
color that will be selected in the Color Preview box at the upper left of the Color
Grid. All selected colors are displayed in the Color Grid in the upper right of the
DensityMask palette.

Plus, you can customize tool options to maximize DensityMask functionality, even
on images that are difficult to mask. For additional information on DensityMask
options, see the Advanced techniques section later in this chapter.
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Cutting with DensityMask

In this procedure, you will experience cutting with the DensityMask tool.

DensityMask tool 1. Click on the DensityMask tool

J

The cursor changes to the DensityMask cursor.

.y

Reuiwrus

DensityMask cursor

2. Draw a frame to define a specific area of an image
Tip: You can select the entire image area by double clicking anywhere on the

image.

A marquee is displayed, denoting the area that will be affected by the
DensityMask settings.
3. Click on a color to select it

All pixels that match selected color are marked on the screen.

4. Click the OK button in the DensityMask palette
Marked pixels are included in the mask.

Once you select the DensityMask tool, only the Pan, Full Detail, and Zoom tools

are available until you click the OK or Clear button in the DensityMask palette.
If the DensityMask palette is not visible, select the DensityMask item on the View
menu.

The Rectangle and Oval tools enable drawing of regular rectangle and oval shapes
to create your masking area.
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Cutting Rectangles and Ovals

Because the Rectangle and Oval tools are so similar in function, a single procedure
is described below.

Rectangle tool 1. Click on the Rectangle or Oval tool

2. Drag the cursor to draw the shape around the element you want to include

Oval tool 3. Release the mouse button

The shape you drew is displayed.

The Zoom tool sets magnification of the displayed image. You can Zoom-in to
view an enlarged representation of a section of the image or zoom out to see more
of the image.
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Using the Zoom tool

In this procedure, you will zoom in and out in the image area.

Zoom tool 1. Click on the Zoom tool

L The cursor changes to the magnifying glass with a plus (+) sign inside the lens.

/R

Zooming cursors

2. Click a point on the image
The view of the image is magnified, using the point where you clicked as the

center of the magnified area.

Tip: You can also drag around a specific area so that it zooms to fill the entire

window.

Dragging the zoom rectangle
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m When you zoom-in, no additional color or pixel information is shown. The same

information is simply displayed larger.

You zoom out, making more of the image visible in the window, by pressing and
holding down the Option key when the Zoom tool is selected. The zoom cursor
changes to a magnifying glass with a minus (-) sign inside the lens.

Tip: You can also use the keyboard shortcuts Command plus + (the plus key) to
zoom in and the Command plus - (the minus key) keys to zoom out.

The Full Detail tool displays the image at a magnification of one screen pixel for
each data pixel in the image file. This is the highest level of detail available. Using
the Full Detail tool is most useful for cutting masks on highly complex image
elements and for refining the area enclosed in an existing mask.
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Using the Full Detail tool

In this procedure, you will zoom in to the maximum magnification possible.

1. Click on the Full Detail tool

Full Detail tool Q

2. Click a point on the image

The view of the image is magnified, using the point where you clicked as the
center of the magnified area.

The Invert tool inverts the included areas of the current mask. The areas currently
masked are removed and the unmasked areas are included. Inverting a mask is
particularly effective for determining where you may have missed including small
areas in a complex masking operation.
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Using the Invert tool

Invert tool 1. Click on the Invert tool

2. Click on the image

The areas of the image that were masked become unmasked, and the areas that
were unmasked become masked.

Clicking with the Invert tool a second time causes the image to revert to its

original appearance.

Regular and Inverted display
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Advanced Techniques

This section contains supplemental information for working within the image
window and refining settings for the AutoMask and DensityMask tools. Before
beginning work in this section, you should understand the functionality of
MaskCutter tools. If you need a review of this information, see the “Using
MaskCutter tools” section, earlier in this chapter.

Window elements

When you first open an image for masking or open an existing mask, you may see
several smaller windows open as well. These windows are located where they
were when the application was last used. Positions described in the following
paragraphs discussing these window elements are the default locations of these
items. The View menu contains commands that control visibility of the windows
and palettes described.

The Toolbox, displayed along the left edge of the window, contains the tools you
use for masking the image. The Navigator window, displayed at the top right of
the screen, shows a reduced version of the full image.

You may also see palettes for refining settings for AutoMask and DensityMask
displayed in various positions on the screen. These palettes are discussed in detail
in the following sections.

When the entire image does not fit inside the image window, scroll bars appear
along the right side and across the bottom. You can use the scroll bars to adjust
the visible portion of the image, similar to the functionality of the Pan tool.

The Zoom indicator, at the bottom left of the image window contains the current
magnification value of the image.

The Separations indicator, at the bottom left of the image window contains the
color values for the currently selected separation. Depending on the separations
you set, the indicator shows three separations (CMY or RGB), four separations
(CMYK), or only one separation when the separations mode selected is 8-bit

Grayscale.

Bl CpE ©

Separation and Zoom Indicator
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In the figure on the previous page, the settings on the left indicate selection of
three separations (CMY) in Full Detail view, and the settings on the right indicate
that only one separation is visible and the image is zoomed to 2:1 magnification.

Starting AutoMask

AutoMask is used to draw a new polygon or to add to an existing one. If you
select AutoMask when an incomplete polygon is drawn on the image, AutoFrame
starts at the last point of the existing polygon.

When you select AutoMask to draw a new polygon, you must click somewhere on
the image to position the AutoFrame. You should click on or close to the image
element edge. Starting from the point where you click, MaskCutter searches for
the closest edge and places the first polygon point there.

SuperAutoMask

SuperAutoMask replaces the need to drag the AutoFrame along the edge of the
image element you are masking. The SuperAutoMask option is enabled after you
have clicked an initial point on the image.

Tip: SuperAutoMask is most suited for highly contrasted image sections.

As you move the cursor on the screen outside the AutoFrame, the cursor changes
to the word Go above a + sign. Click on the image to initiate automatic tracing
from the last polygon point toward the point you clicked. Cutting stops when one
of the following occurs:

* AutoFrame comes up to the edge of the Picture Display window.

* You pressed any key or clicked the mouse button

* The system can no longer determine where an edge is located and sounds a beep
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Since MaskCutter is applying edge detection algorithms to the area inside the
AutoFrame, the resulting line may not draw exactly along the edge you expect.
In addition, since the separation option you select from the AutoMask palette
determines how the algorithms apply, you will want to experiment to get the feel
for using the SuperAutoMask function. Once you master the technique, you

will notice a marked increase in your mask-cutting performance.

In this example, the AutoFrame is positioned at the bottom left point of the flower
within the frame. The picture on the right shows what happens after the
SuperAutoMask cursor is clicked above and to the right of the AutoFrame: The

polygon edge automatically draws until it reaches the edge of the image window.

AutoMask controls

Using controls in the AutoMask palette, you can set characteristics that determine
how the image area is to be masked. You make selections that specify the separa-
tion, or luminance, to be analyzed, the size of the AutoFrame, the degree of
smoothness of the drawn line, and the choke of the drawn polygon from the
detected edge.

E AutoMask
Separation
Size:
Size Bar e e ——
Smooth: Very
Smoothness Bar o
Choke: Direction Indicator
A |
Choke Distance mage Edge

Drawn Polygon

AutoMask palette

Chapter 3: MaskCutter Tools 39




Separations

By default, MaskCutter displays three separations (C, M and Y) for CMYK and
CMY images, and three separations (R, G and B) for an RGB image. However,
you may choose to display all four separations of a CMYK image or any single

separation (C, M, Y, K, R, G or B). You can also display each separation sepa-

rately as an 8-bit Grayscale image.

Displaying three separations instead of four for a CMYK image increases speed
and throughput. The quality of the mask is not affected because in most images,

the fourth separation, black, does not contain data useful for masking,.

Selecting an AutoMask Separation

Using the AutoMask palette, you can select the color of the separation for
AutoMask to analyze, or choose Grayscale or luminance. The color of the
AutoMask cursor reflects the separation AutoMask is using for analysis.

AutoMask can detect an edge while analyzing all the separations, a single separa-
tion, or a Luminance separation, a combination of all the separations and the
default setting.

m Try changing the separation selected as you progress with the AutoMask tool to

gain the best results for the area of the mask you are currently cutting.

While marking an edge using AutoMask, you should choose the separation that
results in the most clearly defined edge. This selection specifies the separation
AutoMask uses when applying its edge-analysis algorithm. If you are not sure
which separation to select, use the Luminance separation.

* AutoMask analysis applies only to the separation selected in the AutoMask
controls, not to all displayed separations.

For example, if a person is wearing a blue shirt against a light background, Cyan
is probably your best bet. However, when masking skin tones in the arms, you
may get better results using Magenta.

* Only the displayed separations are available in the AutoMask palette.

For example, if only the Magenta separation of an image is displayed, only the
Magenta separation can be AutoMasked.
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m You can also select the AutoMask separation using the horizontal arrow keys on
the keyboard.
AutoFrame Size

You adjust the size of the AutoFrame by clicking on the Size bar in the AutoMask
palette. Clicking toward the right side enlarges the frame, and clicking toward the
left shrinks it. You can also drag the slider to change AutoFrame size.

AutoFrame size

The size of AutoFrame affects the area that is scanned and analyzed. The larger
the AutoFrame, the more pixels it can encompass and the more computation is
required.

Generally, a larger frame is more convenient since it allows more room for
operator inaccuracy while tracing the edge. A small frame can be useful when
tracing a contour with fine detail.

m You can also use the keyboard shortcuts, the vertical arrow keys to enlarge or

shrink the AutoFrame.
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AutoMask Smoothness

You define the smoothness used for the AutoMasked edge by clicking on the
Smoothness bar in the AutoMask palette. Clicking toward the right side of the
bar results in a smoother mask edge, and clicking roward the left leaves the
originally detected edge unsmoothed. You can also drag the slider to adjust edge
smoothness.

Four smoothness levels are available: None, Some, More and Very. These levels
are displayed as you drag the slider bar.

None is selected when the smoothness slider is moved toward the left side of the
bar.

Very is selected when the smoothness slider is moved toward the right side of the

bar.

Polygon smoothness - None/Very Smooth

This example shows the difference in smoothness of the polygon edge when None
is selected and when Very is selected.
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AutoMask Choke

The AutoMask choke value determines the distance between the actual detected
edge and the line AutoMask cuts. You can type in a value, defined in image
pixels, or move the graphical representation of the polygon, the thin line, relative
to the graphical representation of the image edge, the thick line. The distance
between these two lines is the choke value.

Direction
Indicator

Choke :

Choke distance

Drawn Image
Polygon Edge

AutoMask Choke controls

Choke distance

Choke :

Choke Distance
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The following example describes automatically cutting on the image (represented
by the thin line in the AutoMask Controls), relative to the image edge (represented
by the thick line in the AutoMask Controls) for different AutoMask Control
settings.

® The example on the previous page shows the graphical representation of a
polygon line drawn to right of the image edge. The tracing direction is down-
ward and the choke value is 2.30. So when you trace the image downward, the
polygon is automatically drawn 2.30 pixels to the right of the image edge.

¢ The example below shows a graphical representation of a polygon line drawn
to the left of the image edge. The tracing direction is downward again, and the
Choke value is 2.30 again. So when you trace the image downward, the
polygon is automatically drawn 2.30 pixels to the left of the image edge.

Image
Edge

Choke :

Choke distance

Drawn Direction
Polygon Indicator

AutoMask Choke
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Direction Indicator

The small red square at one end of the graphical representation of the image edge
is the Direction indicator. When you trace an image element, the direction
indicator adjusts, showing the direction of movement relative to the traced edge

choke value.

The same choke setting may cause the choke to be on the inside of an image
element when you trace the image in one direction, and on the outside when you

trace the element in the opposite direction.

Choke: Choke :

AutoMask Choke - Tracing Direction

In this example, the drawn line is offset to the inside when drawing up and to the

outside when drawing down.
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AutoFrame Color

You may need to change the AutoFrame color from so that you can distinguish it
from the displayed image. When you double click on the AutoFrame, the stan-
dard Macintosh Color Picker window is displayed, allowing you to choose an
AutoFrame color.

Pick Automask Tool Color:

Hue

Saturation |54305
Brightness |60949

EHEDED

E¥|

Red | 60949
Green | 14324
Blue | 10445

= ED

Color Picker window

BT The name of the Color Picker window changes according to the tool that you are
using. In the picture shown above, it is being used for selecting the color of the

AutoMask tool.
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Using DensityMask

DensityMask is especially helpful for separating an element from its background.
You include colors to be affected by DensityMask by clicking on them and setting
a Tolerance value. As you click a color, each pixel within the tolerance range is
included in the mask. Adding more than one color is quite useful when the area
that you wish to mask does not have a uniform color.

When you select the DensityMask tool and position it over an image, the cursor
changes to the DensityMask cursor. At this point you can either set the
DensityMask Controls or select an area in the image.

DensityMask activated cursor

DensityMask Controls

Controls in the DensityMask palette let you specify a range of options for includ-
ing areas in a mask. The following sections describe settings specific to each
control in the DensityMask palette.

7] |
Tolerance :

— Effects ————————
) contiguous =
£ Fan: Effects
@ AN istands

O fsland Size: =1
Choke ber  |Ie i D s

Smoothniess bar --—-—-—M_i- —

DensityMask palette

Chapter 3: MaskCutter Tools 47




Selecting a color from the displayed image instructs DensityMask to include all
image pixels of the same color in the mask. Each color you click on gets added to
the Color Grid in the DensityMask palette.

When you click on a color to be added to the mask the cursor changes to the
DensityMask color-select cursor. At this point, you can click on a color to add to
the DensityMask color grid.

B

N\

DensityMask color-select cursor

You specify a Tolerance value to define a range of colors sufficiently close to the
selected hues, so that all pixels within this range are affected. The higher the
tolerance value, the wider the range of pixels affected.

m Increasing the Tolerance value produces a effect different from adding colors to

the mask. You will want to experiment to get the feel for using the DensityMask
tool.

You can elect to include only contiguous areas around the selected points in the

mask and whether the mask should include or exclude “islands™ of color, those
areas that usually appear as specks or visual noise.
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Color Grid
The color grid:

* Displays the colors for the DensityMask.

* Displays the color at the cursor’s current position. This is, it shows the color
that would be selected if you clicked on the current point on the image.

» Allows you to delete colors previously selected.

Preview Color Box

Eraser

Selected Colors

Color Grid
You add colors by clicking on them in the image.

You can select only colors that are inside the area you defined when you began

working with the DensityMask tool.

You remove a color from the DensityMask by clicking on the color in the Color
Grid. You remove all colors from the color grid by clicking the eraser at the top
right corner of the Color Grid.

Tolerance

Once the color to be masked is selected, you can specify a range of similar colors
to be included in the mask. The range is determined by the Tolerance value that
you set.

You specify tolerance by typing in a value and pressing the Return key or by using
the arrows. Acceptable values are between 0 and 100.
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m You can also adjust the Tolerance value using the vertical arrow keys.

Tolerance changes are displayed interactively on the image, so that each time you
change a value, you will see the results on the mask immediately.

ie=———=——— Mode| EE=——=—=—=Mi1

In this example, a model photographed against a relatively uniform background is easily cut out by selecting several
colors present in the background. The model can then be placed on another background.

C[E——— Flower ———Fi =—— Flower EH=—— Flower @]

This example shows the effect of the Tolerance value when a point on the flower is selected

¢ The left picture shows the original image before DensityMask is applied.

* The center picture shows the area that is masked when a low Tolerance value is
specified. Only colors that are very similar to the selected one are masked.

* The right picture shows the area that is masked when a high Tolerance value is
specified. A wide range of similar colors is masked.
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Contiguous

Contiguous means touching or adjacent. When activated, the mask that is created
only includes areas in the image that are contiguous with the point that you
selected. So that even though an area matches the color selected, it will not be
affected unless it is contiguous to other areas already included.

For example, say you want to mask out a person from a background. You know
that some of the background colors also appear in the person’s eyes, but you don’t
want to include those pixels. To prevent including the same-color eye pixels, you
would activate Contiguous so that only pixels that form an area contiguous to a
selected point are masked.

(AT Flowers =7 Flowers ES==@l [IOES==1 Flowers S0

This example shows the effect of the Contiguous option.
® The left picture shows the original image before DensityMask is applied.

® The center picture shows the area that is masked when Contiguous is active.
The two flowers which are not touching the selected flower are not masked.

® The right picture shows the area that is masked when the Contiguous option is
not activated. All similar areas of color are masked; that is, all the flowers are

masked to some extent.

When Contiguous is selected, you can still add non-contiguous areas to the mask
by holding down the Shift key as you click.
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When you press the Shift key, the cursor changes to the Adding non-contiguous
area cursor. At this point, you can select additional areas into the mask by
clicking on them.

.

Adding non-contiguous area cursor

The interactive display of Contiguous depends on the Preview mode that you
specify in the DensityMask palette. When Effects Preview is active, Contiguous is

displayed interactively. When Effects Preview is inactive, Contiguous is not
interactively displayed.
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Fill Islands

An island is an area of the image completely surrounded by the masked area.
Functionally described, it is an area completely encompassed by a color within the
specified color range. You can include these islands in the mask by activating Fill
Islands. This option is especially useful for filling in small islands of color which

are image specks or visual noise.

For example, when you mask an image element that lays against a light back-
ground, the background may be of nonuniform texture and contain certain specks
or visual noise. This makes it very difficult to mask the entire background by
specifying colors and tolerances. A number of isolated areas may remain un-
masked. So you would activate Fill Islands to include these areas in the mask.

Island Size lets you control the size of islands to be included in the mask. Enter
the maximum pixel area that you want to be included in the mask. Islands larger

than this value are ignored.

If you select All, then all the areas encompassed by the masked area are filled.

In this example, selecting All results in the islands in the background being
included in the mask. This occurred because these areas are completely sur-
rounded by background color.

The interactive display of Fill Islands depends on the Preview mode that you
specify in the DensityMask palette. When Effects Preview is active, Fill Islands is
interactively displayed. When Effects Preview is inactive, Fill Islands is not

interactively displayed.
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Effects Preview

Effects Preview enables you to interactively view the changes in the Effects fields,
namely the Contiguous and Fill Islands fields. Click on Effects Preview to activate
this option. When you click on the point at the cursor position, you can see a
preview of the exact pixels that will be selected.

Effects Preview - On/Off

The DensityMask effects may require some computation, therefore try switching

off the Effects Preview whilst carrying out several changes.

Choke

Choke affects the DensityMask by shrinking or expanding the masked area. The
choke value controls the distance between the image edge and the cut mask edge.

You specify the Choke value using the Choke bar in the DensityMask palette.
Acceptable values range from +2 to -2 image pixels. You click toward the right
side of the bar to increase the value, shrinking the masked area. You click toward
the left side of the bar to decrease the value, expanding the masked area.

Choke value changes are not interactive on the display. You must press the OK
button in the DensityMask palette to initiate Choke value changes.
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Smoothness

You can define the smoothness of the edge of the DensityMask by setting the
Smoothness bar in the DensityMask palette.

There are four smoothness levels in the Smoothness bar: None, Some, More and
Very. You click or drag the slider toward the right to get a smoother masked edge,
and toward the left to leave the originally detected edge.

Flower S==——=F

Polygon smoothness - None/Very Smooth

This example shows the difference in smoothness of the polygon edge when None
is selected and when Very is selected.

Smoothness changes are not interactive on the display. You must press the OK
button in the DensityMask palette to initiate Smoothness changes.

Chapter 3: MaskCutter Tools 55




Clear

You press the Clear button to erase the existing DensityMask area. The selected
colors and settings remain, so you can apply them to a different area on the image.

You can also use the keypad - (minus) key to clear the currently defined
DensityMask area.

OK

When you press OK, all settings and effects are taken into account and the final
mask is created.

You can also use the keypad + (plus) key to save the masked area.
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Chapter 4: Menu Options

This chapter contains descriptions of the menu commands available in
MaskCutter. Although you will find some procedure steps here, the information
in this chapter is intended primarily as reference.

For a summary of the contents for each chapter in this manual, see the “Introduc-
tion” chapter. In addition, you can find suggestions of where to look for informa-
tion in the Going beyond the basics section in the “MaskCutter QuickStart”™
chapter.

File Information
File information that describes the image file is available while you work in

MaskCutter. When you hold down the cursor over the Zoom indicator at the
bottom left of the screen, the File Information window is displayed.

File Name : Model
File Type: EPSF
Separations : 3
Res. (height): 12.0
Res. (width): 120
Size (k bytes): 929
Height (pixels): 482
Width (pixels): 485

File Information

The name of the file may be truncated to fit in the window. Typically, only the
first 14 or 15 characters are displayed.

Resolution is specified in dots per mm.
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File Menu Commands

The File menu contains commands for creating a new mask from an image,
displaying an existing mask and its corresponding image, saving a mask, removing
modifications to a mask, and closing the application.

Open Image & New Mask... ®N
Open Image @ Enisting Mask... %0
Close =W
Save %S
Save As...

Revert to Saved

Quit ®0

File menu

Open Image & New Mask

Use the Open Image & New Mask command to create a new mask for an image.
When you choose Open Image & New Mask from the menu, The Choose Image
dialog box appears. What options appear in the dialog box depends on the view
type selected in the pop-up menu at the upper right of the dialog box.

When you choose List from the pop-up menu, you get a listbox containing image
names and a visual preview of the image.

Choose Mask File to Edit: Ulew:
3 MaskCutter v = Ravanelli Preview:

T —

I

= Open

Type: CT Size: 984 KB Craate Prepiew

Choose Image File window - List
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When you choose Pictorial from the pop-up menu, you get a gallery window
containing representations of all the images in the current directory.

Choose Image File to Mask: Uiew:

® -
L
=
Flower Model U

AL

B l Open l

Type: CT Size: 866 KB

Choose Image File window - Pictorial

If you see a blank box with an X through it instead of the visual preview of the
image, try pressing the Create Preview button to generate a preview image. You
will only need to create a preview once because the representation is automati-
cally saved with the image file.

A preview representation is also present for one of the following reasons:

* The image file was previously opened and saved using the MaskCutter applica-
tion

* You previously pressed the Create Preview button for this image
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Open Image & Existing Mask

Use the Open Image & Existing Mask command to modify an existing mask file
created by MaskCutter. The Choose Image dialog box displays when you select
Open Image & Existing Mask. The dialog box is identical to the one that appears
when you select Open Image & New Mask. For details on the Choose Image
dialog box, see the previous section.

Each saved mask file contains a pointer to the image file for which it was created.
If MaskCutter cannot find the referenced image file, you are prompted for its
location. For MaskCutter to function, the image file must be present and must be
named as it was when you created the mask.

Close

Use the Close command to close the current mask file. If you made any changes
since the mask was last saved, you will be prompted to save them.

Save changes to “Model™ before
closing?

(omnt ) (o ) [ve )

In this example, the file named "Model” had changes made but not saved.

Save

Use the Save command to save the current mask to a file. By default, the mask file
is saved under the image file name with a suffix appended. This suffix represents
the file format in which the mask was saved.

The following section, Save As, contains a description of each type of mask file

format. For an explanation of the suffixes used for each mask file format, refer to
the Suffixes section in Edit Menu Commands, later in this chapter.
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Save As

Use the Save As command to save an existing mask under a different name or
using a different mask file format. You can assign any name that you wish.
However, by default the mask file is saved under the image file name with a suffix
added to its end. This suffix represents the file format in which it is saved.

When you select Save As, the standard Macintosh Save As dialog box displays. In
addition to the standard controls, MaskCutter provides a pop-up menu from
which you select a file format.

€3 MaskCutter v = Ravanelll
0 Flpwer 7] Elact
1 mMadel {j—]
Desktop
= A
Save mask as: [ cancel ]
_—— '
File Format: [ HaskCutter v}

Save As dialog box with File Format pop-up

You can elect to save masks in one of three file formats: MaskCutter, PSImage or
EPS. A description of each file format follows this section.

A different suffix for each file format is provided for workflow convenience. You

need not use the suffixes provided, nor do the files require a suffix for
MaskCutter to function.
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MaskCutter Mask File Format

MaskCutter format is the native format for storing a mask. This format contains
image preview data and a pointer to the image file for the mask. It is the most
compact representation of the mask data.

Since the format is so compact, try saving as often as possible as files are saved
quickly.

PSImage Mask File Format

PSImage format is an EPS (Encapsulated PostScript) file that contains Scitex
Automatic Picture Replacement (APR) information. The PSImage file contains
mask information as a PostScript clipping path, with optional preview image and
proofing data. Scitex APR technology takes the low resolution proofing data in a
PSImage file and replaces it with the high resolution image when the page is
ripped.

PSImage format takes advantage of APR when you use a desktop page layout
program, such as QuarkXpress or Adobe PageMaker. Scitex APR is supported by
all recent Scitex RIPs.

Additional option specifications are needed for masks saved in PSImage format.

* Format of the proofing data (None, Grayscale, Indexed or CMYK).

If you select None, only the image name is printed when you print this image.

® Preview data (None, Macintosh, or DOS).

¢ Proofing data encoding format (Binary or ASCII).
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This parameter determines how the image data is written in the PostScript file.
Binary encoding is more efficient and is reccommended whenever possible.
However, some applications may be incompatible with binary encoding.

* High resolution file creation. Select from None (no high resolution file), EPSF
(high resolution file in EPSF format), or Scitex CT (high resolution file in Scitex
Continuous Tone format).

€3 MaskCutter v = Ravanelli

O Flower []
D Tiowe
B e e
Save mask as:
[teaere 1

File Format:

Options:

Proof Date
previews:
Encoding:
W-fes:

PSimage format options
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EPS Mask File Format

This format saves the mask as a standard, PhotoShop compatible, EPS (Encapsu-
lated PostScript) file which does not contain any APR information. An EPS file
contains the mask information as a PostScript clipping path and the complete
image data.

Use EPS formart when you want to use the mask in a desktop page layout pro-
gram, but you will not need the Scitex APR information. Also, when you plan to
edit the mask in a PostScript application (such as PhotoShop), you'll want to save
the File in EPS format

Additional option specifications are needed for masks saved in EPS format.

¢ Preview information format (None, Macintosh, or DOS).

* Proofing data encoding format (Binary or ASCII).

This parameter determines how the image darta is written in the PostScript file.

Binary encoding is more efficient and is recommended whenever possible.
However, some applications may be incompatible with binary encoding.

|Cﬂ MaskCutter v I = Ravanelli

3 Flower K
1 Madel

1=

Save mask as:

EmEmers I

——
g: [ Binary «]

EPS format options
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Notes on File Formats
* MaskCutter can open any files saved in one of its supported formats.

* To prevent loss of accuracy when reopening a file, native mask representation is
always saved in the mask file, in addition to other dara.

¢ MaskCutter EPS file can be opened in PhotoShop, where you can edit both the
image and the mask.

Chapter

¢ PhotoShop EPS files can be opened by MaskCutter. If the EPS file contains a
PhotoShop clipping path, the path appears as a mask and can be edited.

Revert to Saved

Use the Revert to Saved command to discard all changes and additions performed
since the last save.

Quit
Use the Quit command to close existing files and exit the MaskCutter application.

If an open mask contains changes that have not been saved, you are prompted to
save them before quitting.
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Edit Menu Commands
The Edit menu contains commands for undoing operations, closing a polygon,

inverting, clearing an entire mask, and preference options for cursor and keyboard
shortcut definitions.

Undo 2

Close Polygon #®K
Invert Mask  #¥1
Clear Mask...

Preferences »

Edit menu

Undo

Use Undo to discard the previous operation. The undo string is specific to the
operation to be undone.

Undo Oval Deletes a mask element cut using the Oval tool
Undo Rectangle Deletes a mask element cut using the Rectangle tool
Undo Point Deletes the last polygon segment cut using the

Polygon or Smooth Polygon tool

Undo AutoMask Deletes the last polygon segment cut by the
AutoMask tool

Undo DensityMask Deletes the last mask segment added by the
DensityMask tool
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Close Polygon
Closes a polygon.

Invert Mask

Inverts the masked area, so that the masked area is revealed and the unmasked
area is masked.

Clearing a Mask

Use this option to erase the entire mask defined for the image. When you select
this command, a warning message appears.

You cannot undo this operation, so proceed with caution.

fire you sure you want to
remove the current mask?

Caution!

(concer ) f ox

You can click OK to remove the current mask definition or Cancel to return to
mask-editing operations.

If you saved the mask before you selected this command, you can restore the file
to its previous saved state using the Revert to Saved command in the File menu.
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Preferences
Cursor Shape

Changes the shape of the cursor used for masking. This function affects the
cursor used by the Polygon, Smooth Polygon, Rectangle and Oval tools. All other
cursors are not affected. The following window is displayed for your selection.

B HBEE

Cursor Shapes
Select a cursor shape and click the OK button.

Hot Keys

Keyboard shortcuts enable temporary access to a tool, while you are using another
tool. As long as the hot key is pressed, the tool it represents is active. When you
release the hot key, the original tool is reactivated.

For example, Hot key may be helpful when masking an image with the AutoMask
tool. You may be using the AutoMask tool most of the time, but occasionally
want to use the Smooth Polygon tool. Activate the AutoMask tool and when you
need the Smooth Polygon tool, press and hold the 2 keypad key to apply the
Smooth Polygon tool. Release this key to revert to the AutoMask tool.

Assign a hot key to each masking tool. To achieve maximum efficiency, carefully
select your hot key configuration to suit your work habits.
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Pan <Space bar>
Polygon 1 keypad
Smooth Polygon 2 keypad
AutoMask 3 keypad
DensityMask 4 keypad
Rectangle 5 keypad
Oval 6 keypad
Zoom z

Select the tool for which you wish to define a hot key by clicking on it. The
defined hot key is displayed in the Hot Keys window, as shown below:

Keyboard Shortcuts

o o
4@ (type to set key)

©le |8 |~

Hot Keys window

The Full Detail and Invert tools cannot be defined as hot keys.

Chapter 4: Menu Options 69

Chapter



Suffixes

When you create and save a mask for an image, a suffix representing the file
format is appended to the end of the generated mask filename. This functionality
is designed to facilitate workflow operations by recording which files are in which

formats. However, files do not need suffixes to work properly in MaskCutter.

File Suffin Preferences:

«MaskCutter
PSimage
EPSF
Sciten CT
Ly
M5

x|

File Suffix Preferences window

The default suffixes are presented in the following figure. To change the default
suffix, edit the suffix text.

MaskCutter MSK

PSimage E

EPS EPS

Scitex CT CT
PostScript

You are able to set the PostScript quality standard for the masks you cut, ranging
from Highest to Very Low.
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View Menu Commands

The View menu contains commands for customizing the view of the image in the
window, specifying settings for AutoMask and DensityMask operations, and
controlling visibility of the palettes.

Chapter

Previous 6
Full Detail ®F
Actual Size A
Mask Color »
Mask Appearance D
Polygon Color »
Frame Color »

v Frame Mask

Separations

+Tools
Navigator
AutoMask Controls
DensityMask Controls

View menu

Previous

Displays the previous setting used to view the image. The previous view may have
been 2:1 zoom, Full Detail, or Actual Size.

Full Detail

Full Detail displays the image using one screen pixel for each data pixel in the
image. This is the greatest level of detail available and is the minimum required
for all masking operations. When you zoom-in or enlarge the image further, it
appears larger, but more color or pixel information is not shown.

Actual Size

Displays an image in the 1:1 size used when the file is output. Actual Size serves
as more of a “print preview” since detail is insufficient for most masking opera-
tions. In addition, the AutoMask and DensityMask tools are disabled in Actual
Size view when it is different to the Full Detail size.
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Mask Color

Using Mask Color, you can change the color used in displaying the mask. You
will probably have to change this option to keep the mask visible when you work
with color images.

Mask Appearance

Using the Mask Appearance, you can change how the mask cuts on top of the
image. Selecting Opaque makes the mask solid so that you cannot see the image
beneath the mask. A Translucent setting allows you to see the image beneath the
mask. Selecting Pattern results in a mask of a striped pattern. An Inverse setting
inverts the colors in the image area under the mask.

Mask Color

Polygon Color B, Transiucent

Frame Color » %, Pattern
+Frame Mask

Mask Appearance

Polygon Color

Selects the color of the polygon line cut by the Polygon, Smooth Polygon and
AutoMask tools This color displays only while you are drawing the polygon,
before it is closed.
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Frame Color

Selects the color of the outer edge of a masked area. This option is only available
when Frame Mask is visible.

Frame Mask

Toggle this option to determine if the color of the outer rim of a masked area is
different than the rest of the masked area. The color is different when a v ap-
pears to the left of this option, and is the same when no V appears.

When this option is active, you can select a Frame Color, as described above.

Separations

Separations are discussed at length in the Advanced Techniques section of the
“MaskCutter Tools” chapter, earlier in this manual.

Tools

Toggle this option to show or hide the MaskCutter Toolbox on the screen. The
Toolbox is displayed when a check mark appears to the left of the option.
Navigator

Toggle this option to display or hide the Navigator window. The Navigator
window is displayed when a check mark appears to the left of the option.
Navigating within an image

MaskCutter provides a small Navigator window, which shows a smaller version
of the complete image. A colored locator rectangle encompasses the portion of
the image currently visible in the main Picture Display window.
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Here are two examples of how you can use the Navigator Window to speed your
work along.

Let’s say you have zoomed to 2:1 to work in a particularly detailed area of the
image. When zoomed, the entire image no longer fits in the main window.
However, a colored rectangle in the Navigator window shows which part of the
entire image is currently displayed in the main window.

You can also use the locator rectangle to navigate the displayed image in the
Picture Display window. Click and drag on or inside the locator rectangle in the
Navigator window to navigate the displayed image in the Picture Display window.

Drag the locator rectangle to the bottom left of the Navigator window in order to
view the bottom left of the image in the Picture Display window, as shown below.

Navigator window - Locator Rectangle

You can change the color of the locator rectangle by double clicking on it.

AutoMask Controls

AutoMask Controls are discussed at length in the Advanced Techniques section of
the “MaskCutter Tools” chapter, earlier in this manual.

DensityMask Controls

DensityMask Controls are discussed at length in the Advanced Techniques section
of the “MaskCutter Tools™ chapter, earlier in this manual.
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Chapter 5: Workflow Scenario

The most common production environment for MaskCutter is the Postscript
desktop. Workflow for this is described in this chapter.

Postscript Desktop Workflow

MaskCautter allows seamless integration into the desktop production environment
where it can greatly enhance existing masking capabilities. Using the Macintosh,
you can mask CT files (CMYK or CMY), TIFF images (RGB, CMYK, Indexed,
Grayscale, and the new 16 bit-per-separation HDR format), and PhotoShop-
compatible EPS files.

Bring TIFF or
Scitex CT to
Macintosh

/

Use Scitex
MaskCutter to
Cut a Mask

7

Save Mask
as EPS or
PSImage file

/7

Print Page to a
PostScript RIP
for output

Postscript Environment workflow
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Using an optical disk or network drive to transfer files to the Macintosh is
recommended.

* Bring the CT, TIFF, or EPS file to a Macintosh
e Cut masks for the images
¢ Save the mask in EPS or PSImage format

* Copy or import the EPS or PSImage mask into a page-layout application, such
as QuarkXpress or Adobe PageMaker

e Print the page onto a Postscript RIP, such as the Dolev PS or Dolev PS/M, for

film output
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Notes on Output

A PSImage file is a relatively small EPS file that contains a Postscript clipping path,
essential image data, a low-resolution image preview, and Scitex Automatic
Picture Replacement (APR) comments. During output of a file with APR com-
ments, the low-resolution information is replaced with high resolution images.
You’ll want to save in PSImage format when you intend to take advantage of
Scitex APR.

All recent Scitex RIPs support PSImage APR.

If you output to a non-Scitex RIP that does not support PSImage APR, you’ll want
to save the mask as EPS. Though the EPS file is much larger than the PSImage file,
the same high quality mask will be output.
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Background Copy

Macintosh System 7 fully supports copying files in the background. This allows
you to begin working right away. You will need to launch MaskCutter before you
start your copy because the Finder cannot launch an application once it has begun
copying files.

The procedure described below works equally well when copying from local or
remote storage devices.

¢ Launch MaskCautter.
¢ Drag all image files from the remote mounted volume to the RAM disk.
¢ Wait until at least one file copy is completed.

® Switch from the Finder to MaskCutter by choosing it from the Applications
menu at the top right of the screen.

¢ Start masking while copying continues in the background.

m You should not experience loss of performance using MaskCutter while files copy

in the background.
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Symbols
24-bit color display 10

A
Actual Size 30, 71
Adding to a mask. See Mask
Advanced Techniques 37
APR 62
AutoFrame. See AutoMask
AutoMask
AutoFrame 29
AutoFrame Color 46
AutoFrame Size 41
Choke 43
controls 39
Direction Indicator 45
Hot key. See Preferences
separation selection 40
Smoothness 42
SuperAutoMask 38
tool 29, 38
Automatic Tools 22. See also Tools

Background copy 78
Binary encoding 63

C
Choke. See AutoMask
Clear
DensityMask. See DensityMask
Mask 67
Close
file 60
Polygon 67
CMY. See Separations
CMYK. See Separations
Color Grid. See DensityMask
Color Picker 46
Constrained cutting 24
Contiguous. See DensityMask
Copy in background. See Background copy
Create Preview 59
CT. See Scitex CT
Cursor Shape. See Preferences

D
Delete
mask. See Clear: Mask
point 23. See also Undo
DensityMask
Clear 56
Color Grid 49
Contiguous 51
controls 47
Effects Preview 54
Fill Islands 53
Hot key. See Preferences
Smoothness 55
Tolerance 49
tool 31, 47
Direction Indicator. See AutoMask

E
Edit Menu 66
Editing. See Mask
Effects Preview. See DensityMask
EPS
file format 64, 65
suffix. See Preferences

F
File
background copy 78
formats 62, 65, 75
information 57
location 60
Menu 58
new. See Open Image & New Mask
transporting 18
Fill Islands. See DensityMask
Frame Color 73
Frame Mask 73
Full Detail tool 30, 35, 71

H

Hardware requirements 9
Hot Keys. See Preferences

Installation 10
Inverse Mask appearance 72
Invert
Mask 67
tool 36
Islands. See DensityMask
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List
Open Image 58
Location of file. See File

Magnification. See Zoom
Manual tools 22. See also Tools
Mask

adding to 28

Appearance 72

Clear 67

Color 72

cutting 14, 21, 23, 24

editing 28

subtracting from 28
MaskCutter

file format 62

suffix. See Preferences
Menu Options 57

Navigating 25, 73. See also Navigator; Pan
tool; Scroll bars
Navigator 73
locator rectangle 74
window 37, 73. See also Navigating
New. See Open Image & New Mask

0
Opaque Mask appearance 72
Open Image & Existing Mask 60
Open Image & New Mask 58
Output 77. See also File: formats
Oval
Cursor shape. See Preferences
Hot key. See Preferences
tool 32. See also Constrained cutting

P

Pan tool 25. See also Navigating
Patterned Mask appearance 72
Pictorial

Open Image 59
Polygon

Close 23
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Cursor shape. See Preferences

Hot key. See Preferences

tool 26. See also Constrained cutting
Postscript

Workflow. See Workflow: Postscript
Preferences

Cursor Shape 68

Hot Keys 68

Suffixes 70
Preview image. See Create Preview
Previous 71
PSImage

file format 62. See also File

suffix. See Preferences

Q
Quit 65

Rectangle
Cursor shape. See Preferences
Hot key. See Preferences
tool 32. See also Constrained cutting
Registration 11
Revert to Saved 65
RGB. See Separations

S
Save 60
Save As 61
Scitex APR information. See APR
Scitex CT
format 75
suffix. See Preferences
Scroll bars 37. See also Navigating
Separations 40
indicator 37
Smooth Polygon
Cursor shape. See Preferences
Hot key. See Preferences
tool 27. See also Constrained cutting

Smoothness. See AutoMask; DensityMask

Software requirements 10
Subtracting from a mask. See Mask
Suffixes 61. See also Preferences
SuperAutoMask. See AutoMask



T

Tolerance. See DensityMask
Toolbox 21, 37

Tools 22, 73

Translucent Mask appearance 72

U
Undo 66. See also Delete

Vv

View Menu 71
Virtual memory 10

W

Window elements 37
Workflow
Postscript 75

Y4

Zoom
Hot key. See Preferences
indicator 37
tool 33
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